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Quick Help at Your Fingertips

This Redi-Kard will get you started with AdminPlus 6 and its different modules, helping you learn some of the most basic tasks you
may do every day. Some of these tasks include: taking and importing attendance, finding students, demoting a student, changing a
grade level of a student, scheduling, and customizing Lookup to help find the information you need quickly.

Navigation
The main screen consists of the toolbar, Shortcut Bar, School and Year drop-downs, User and Version information, and the Program
Background. There are several ways to navigate, but the most popular methods are right-clicking, the toolbar, and the Shortcut Bar.
Shortcut Bar
Access different programs within a module. Clicking the module name opens the menu for that module. All programs within
the module can be accessed by clicking the appropriate icon. To change the size of these icons, click View > Shortcut Bar, and
choose Large Icons, Small Icons, or None.

Toolbar
Access the different modules and programs.

Quick Launch Icons
Launch your favorite tasks, AdminPlus Notify, and School Dashboard
(with information such as attendance, incidents, and trends in attendance).

Right-Click Menu
Right-click anywhere on the program’s
background to access task-based commands
(for example, view a student’s grade).

Program Background
This is the main work area within AdminPlus.
Program windows appear in this main area.

Current User and Version
Your version of AdminPlus and user name appear at
the bottom of the screen.

Hot Keys
Hot Keys enable you to jump from module to module
while viewing the same student’s data. From left to
right are the Hot Keys for the following modules: Data
Base Plus, Attendance Plus, Report Cards, Scheduling,
Discipline, Billing, Pictures Plus, Period Attendance, and
Fast Payments.
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Shortcut Icons
Shortcut icons enable you to quickly access the selected
student’s portfolio and household; configure the Address
screen; print or modify the selected student or staff
member’s data report; send the current demographic view
to Excel; and receive data from PlusPortals, APWeb, and
Online Forms.
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Finding Students

Data Base Module

With Lookup, you can search for students or staff using their
name, ID, or any demographic field displayed.

The Data Base (DB) module is where you add, inactivate,
reactivate, and/or delete students and staff. It is also where all
demographic data is entered for students and staff. The main
programs in Data Base are New Files, Address, and Print.

New Files

? ? Find a Student by any Demographic Field

?

1.
2.

3.
4.

On the Home screen, click Students or Staff, based on
what demographic group you wish to search in.
Do one of the following:
• Click Begins With if searching using the first three
characters contained in the person’s information for the
selected demographic field (e.g. Name).
• Click Contains if searching using any characters contained
in the individual’s information for the field.
Type the student or staff member’s information in the text
box, and click the search icon
(or press the Enter key).
If searching for someone by using a demographic field
other than Name, click the column heading label by which
you would like to search for the person (for example,
APID or Grade).

The New Files
program is where
you add, inactivate,
reactivate, or delete
students or staff, and
demote or promote
students.

? ?Add a Student or Staff Member

?

1.
2.
3.
4.
5.
6.
7.

On the startup screen, right-click > New > Student >
Manual Entry.
Click a grade level, and then click Select.
Type the Last Name, First Name, and Middle Name.
Verify that the information in the Entry Date, Entry Code,
and Language fields are correct.
Click Next [F10].
Use a new Household ID, or link to an existing one.
Click Add this Member, click Next, and then click Done.

? ? Inactivate a Student or Staff Member

?

F9 Print: Generate Quick Reports

1.

On the Home screen, click a student or staff member.

The F9:Print key icon
is found to the far right (together
with other shortcut keys) of most student data entry screens.
Clicking this key generates the default report for the current
screen. You can customize this feature to generate a specific
Report Writer report for the selected student upon clicking.
For example, you can configure this print feature in the
View/Change program in Report Cards to generate a report
card or transcript instead of the default report.

2.
3.
4.
5.

Click the Inactivate Icon
in the Snapshot area.
Click Inactivate this member, and then click Next.
Click Done.
To reactivate a person, repeat steps 1 and 2, and select
the Reactivate this member option.

? ? Customize F9 Print

?

1.
2.
3.

Click any data entry screen (e.g. Report Cards > View
Change).
Select a student.
Right-click the Print icon, and click Change (task name).
Note: Depending on the data entry screen, the right-click
option may also display as Custom Report.

? ? Delete a Student or Staff Member

?

Deleting a student or staff member completely removes
the person from the school year in which he or she was
deleted. However, the individual remains in the past years.
Furthermore, you cannot delete a student with billing data.
1.
2.
3.

In the Data Base module (Shortcut Bar), click New Files.
Click Lookup on the left, find and click the student, and
then click Select.
Click Delete on the left, and confirm the deletion.

? ? Promote or Demote an Individual Student

?

These steps should only be followed when you need to
promote or demote an individual student. You can use the
Beginning program in the Data Base module to mass promote
your students once you’ve created a new school year.
4.

Select a report writing task to set as the new default
report for that screen, and click Select.
Now when you click the F9:Print icon from that screen, the
report associated with the selected task will be generated.

1.
2.
3.
4.
5.
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In the Data Base module, click New Files.
Look up the student.
Click Other [F9].
Click Move to another ID and/or grade Level, and click
Next.
Select the appropriate grade level (and ID), and click Next.
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Address

Print Program

The Address program is where you enter or edit demographic
data for students and staff. Address contains 260 fields on 13
pages (20 fields per page) that can be used to store data.

With the Print Program, you can quickly generate a list, such
as for a homeroom or a team.

? ? Generate a Report Using the Print Program

?

1.
2.

3.

? ? Enter or Edit Student or Staff Demographics

?

1.
2.
3.
4.

In the Data Base module (Shortcut Bar), click Address.
Double-click a student or staff member.
Enter or edit the data. Use the tabs at the top of the
demographic fields area to enter data on other pages.
Click Accept [F10] to save your changes.

4.
5.

? ? Batch Enter Student Demographic Data

?

1.
2.
3.

4.
5.
6.

7.
8.

On the Home screen, click the Other Options icon
on the right.
Click Batch Entry.
Do one of the following:
• Click Grade number, click a specific grade from the list,
and then click Next.
• Click All grades, and then click Next.
Type the data to be batch-entered into the appropriate
database field(s).
Click Accept [F10].
Click one of the
following options,
depending on
whom you want to
batch enter data
for, and click Next:
• Individual
members/
groups: Enables
you to select
individual students who are to have the data entered into
their records.
• All members: You can batch enter data for everyone in
the grade(s).
• Members matching a data base criteria (query):
Have AdminPlus find specific students based on another
database field to apply the batch entry to.
Click Accept [F10].
Once completed, click Abort [Esc] to get back to the
Address screen and verify that the batch entry was
successful.
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6.

In the Data Base module, click Print Prog.
Click a report type:
• One column with additional fields enables you to
generate a list containing Student Name, ID, or any other
database fields (such as Homeroom and Phone).
• Three columns generates a report of student names and
IDs displayed in three columns.
• Totals only creates a report with just totals, no names.
If you click either of the one-column options, do the
following:
• Hold down the Ctrl key and click any of the fields on the
left to be included in the report.
• Click the arrow pointing to the right to select the fields,
and then click Accept [F10].
• Click one of the print options for additional fields
(Columns, Rows, or ASCII file), and then click Next.
Click a specific grade number, All grades, or Staff, and
then click Next.
Click one of the options that determines which students
to include in the list, and then click Next:
• All Students lists them alphabetically.
• Individual Students enables you to select certain
students to be included in the list.
• Search by One Field enables you to group students or
staff by database field entries. Select a database field,
and the program will search for all entries based on the
selected field and generate a printout for each unique
entry.
• Search by Field(s) (query) allows you to search for
students who meet certain criteria.
After the list is generated, click Print at the bottom right,
and follow your printer’s instructions.

Attendance Module
The Attendance module is where you enter or edit student
attendance. The main programs in Attendance covered in this
card are Enter Daily, Batch Entry, and Correct.

Enter Daily
The Enter Daily program enables you to enter student attendance on a daily basis. You can enter attendance manually, or
you can import attendance from TeacherPlus Gradebook,
GradeQuick, or APWeb Teacher. The Enter Daily program is
also where you can add the current day to your attendance
calendar as well as where you can print the daily attendance
bulletin.

? ? Add “Today” to the Calendar

?

You will be building your calendar daily as you take attendance.
1.
2.
3.

In the Attendance module (Shortcut Bar), click Enter Daily.
(Shortcut: right-click > Enter > Daily Attendance.)
Read the warning, and click Yes.
Confirm the date and membership value, and click Next.
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? ? Manually Enter Student Attendance

?

1.
2.
3.
4.
5.
6.

In the Attendance module, click Enter Daily.
(Shortcut: right-click > Enter > Daily Attendance.)
Create “today” if you have not already done so. (See the
previous instructions.)
Click Manual Entry, and then click Next.
Click a grade level from the Default Grade list.
Type the student’s APID in the ID column, or click Lookup
[F6] at the bottom to locate the student.
Type the applicable attendance code in the Code 1 column,
and then click Accept.

? ? Import Attendance

?

You can import attendance into AdminPlus from the TeacherPlus
Gradebook, GradeQuick (GQ), PDA, or APWeb Holding Bin.
1.
2.
3.

In the Attendance module, click Enter Daily.
(Shortcut: right-click > Enter > Daily Attendance.)
Create “today” if you have not already done so. (See the first
FAQ in this section.)
If importing attendance from GQ, PDA, or APWeb,
click 9. Receive from GQ/PDA/APWeb Holding Bin.

? ? Print the Daily Attendance Bulletin

?

1.
2.
3.
4.

Batch Entry
The Batch Entry program enables you to enter the same
attendance codes for a group of students.

? ? Batch Enter Attendance Codes

?

1.
2.

3.
4.

4.

In the Attendance module, click Enter Daily.
(Shortcut: right-click > Enter > Daily Attendance.)
Import attendance or enter attendance manually.
Click 6. Print Bulletin, and click Next.
After the report is generated, do either of the following:
• Click Print to generate a paper copy of the report.
• Click Convert to PDF to make a PDF of the report, which
can be emailed to staff or accessed in a central location.

If importing attendance from Gradebook, click
B. Receive From TeacherPlus Gradebook.
5.

In the Attendance module, click Batch Entry.
In the Specifications dialog box, set the following specifications, and then click Done:
• For spec 1, set the date
for when the attendance code will be
entered.
• For specs 2 and 3,
select an attendance
code and an
optional time.
• For specs 4 and 5,
enter a second code and time.
• For specs 6 and 7, set the start and end grade levels.
• For spec 8, select a type of student for whom you want to
enter the code.
Click a specific grade from the Grade list, or click All Grades.
Click one of the following options, depending on your batch
entry needs:
• All students: Enables you to batch enter the code for
everyone in the grade(s).
• Individual students/groups: Lets you select individual
students for the batch entry.
• Students matching your DB criteria (query): Allows
you to find specific students (based on data in a particular
database field) who will get the batch entry.
Click Next to begin the batch entry and write the code(s) to
the students’ attendance records.

Correct

5.
6.
7.

Verify that you have the correct import template(s) selected,
and then click Next.
After the Holding Bin appears with your attendance files,
select the files you want to import, and then click Receive
Attendance to continue importing.
Once the import process is complete, close the log, and click
Exception List to get a list of teachers who have not submitted attendance (GQ, PDA, APWeb only).
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The Correct program is where student attendance data is stored.
You can view, enter, and edit attendance data from this screen.
There are three different attendance views:
• Calendar View: Shows student attendance data day by day.
All corrections are made in this view.
• Register Code View: Shows student attendance by Register
Codes. A Register Code is a summary code that describes the
“what” of the attendance status (i.e. Absent, Tardy, etc.).
• Attendance Code View: Shows student attendance by
Attendance Codes. An Attendance Code is a detail code that
describes the “why” of the attendance status (i.e. Absent
Excused, Tardy Unexcused, Absent Medical, etc.).
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? ? Edit an Individual Student’s Attendance

?

1.
2.
3.
4.
5.
6.

In the Attendance module, click Correct.
(Shortcut: right-click > View/Edit > Daily Attendance.)
Make sure the Calendar View option is selected on the left.
Click Lookup [F6] on the left, find and click the student, and
click Select.
Click Edit [F3] on the left.
Type the code manually, or click Code Lookup [F6] to find
the appropriate code.
Click Accept [F10].

? ? Enter an Attendance Comment

?

1.
2.
3.
4.

In the Attendance module, click Correct.
(Shortcut: right-click > View/Edit > Daily Attendance.)
Click Lookup [F6] on the left, find and click the student,
and click Select.
Click the day to be associated with the comment, and
then click Comments [F12] on the left.
Type the comments, and click Accept [F10].

? ? Print a Course or Section List

?

1.
2.
3.

4.

Enter Grades
The Enter Grades program is where you can enter student
grades. Grades can be entered manually by roster (i.e. section),
or they can be imported.

? ? Enter a Grade Manually

?

Report Cards

1.

The Report Cards module enables you to add courses and
sections, enter and edit student grades, run honor rolls, and
perform other similar report card features. The main
programs in Report Cards covered in this card include Enter
Courses, Enter Grades, Statistical Reports, and
View/Change/Add/Drop.

2.
3.
4.
5.
6.

Enter Courses
The Enter Courses program is where you add courses and
sections to AdminPlus. A course is a class or subject (e.g. Algebra
1), and a section is a meeting time, teacher, and room of a
course (e.g. Section 1 of Algebra 1 meets “A” block in room 112,
and it is taught by Ms. Smith).

? ? Add a Course

?

1.
2.

3.

Right-click > New > Course.
In the Select Course
Number to Add dialog
box, click an **UNUSED**
course number, and then
click Select.
Fill out the appropriate
course information, and
click Accept [F10].

? ? Add a Section

?

1.
2.
3.
4.
5.
6.
7.

In the Report Cards module, click Ent. Courses.
Click 1. View/edit courses & sections, and click Next.
Click Lookup [F6] on the left.
Find and click a course, and click Select.
Click Section [F2] at the top left, and then click Add [F2].
Enter the Teacher ID, Meeting Time, and Room Number.
Click Exit [Esc] when you have added all desired sections.
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In the Report Cards module, click Ent. Courses.
Click 1. View/edit courses & sections, and click Next.
In the View/Edit Courses And Sections dialog box, click
one of the following print options, and make a selection to
generate the report:
• Print Courses: Print a master course list by course
number, course name, or by courses with skills.
• Print Sections: Print a section list by course/selection
(CRS/SC), staff, time, course name (CRS Name), or room.
Select what you want to print, and the report will be
generated on your screen.

In the Report Cards module, click Ent. Grades.
(Shortcut: right-click > Enter > Grades.)
Click 1. Enter grades manually, and click Next.
Set your desired specifications, and click Done.
Click Lookup [F6] on the left, click a course, and click Select.
Click Edit [F3] on the left.
Type each grade in its corresponding cell, and then click
Accept [F10].

? ? Import Grades from TeacherPlus Gradebook

?

In the Report Cards module, click Ent. Grades.
Click 6. Receive from TeacherPlus Gradebook, and then
click Yes to sync AdminPlus with Gradebook.
3. Click a marking period in the Current Marking Period list.
4. Click the section(s) you want displayed from the Display
Sections Meeting When list.
5. In Gradebook Columns, select the check box for each
grade column to be imported from Gradebook.
6. In AdminPlus Report Card Columns, make sure each
report card column matches the desired Gradebook column
on the left. The grades from each Gradebook column you
selected in step 5 will be imported to its corresponding
adjacent report card column.
7. Click Next.
8. Do one of the following:
• To receive grades teachers have not officially
submitted, click Except NA at the upper-right corner.
• To receive grades teachers have officially submitted,
click Ready at the upper-right corner.
9. Select the check box for each gradebook you wish to
import grades from.
10. Click Save Grades from Selected Gradebooks.
1.
2.
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? ? Import Grades from GradeQuick (GQ)

?

1.
2.
3.
4.
5.
6.

In the Report Cards module, click Ent. Grades.
(Shortcut: right-click > Enter > Grades.)
Click 4. Receive from Grade Quick.
Set your desired import specifications, and click Done.
Click 1. Receive all sections or 2. Receive individual
sections.
Set the quarter from the drop-down list, verify the start
grade, end grade and receive data by date, and then click
Done.
Once the import is complete, close the log, and click
6. Teacher exception list to get a list of teachers who have
not submitted grades yet.

? ? Import Grades from APWeb Teacher

?

1.
2.
3.

In the Report Cards module, click Ent. Grades.
(Shortcut: right-click > Enter > Grades.)
Click 5. Receive from APWeb Teacher.
Select the check boxes for the section(s) you want to import
grades from, and then click Receive from Holding Bin.
A log appears after the import is complete.

Statistical Reports (Stat Reps)
The Statistical Reports program is used to run honor rolls and
calculate GPAs.

? ? Run Honor Rolls

?

In the Report Cards module, click Stat Reps. (Shortcut: rightclick > Print/E-Mail > Report Cards > Stat Reps.)
2. Click 1. Honor Rolls, and click Next.
3. Click 1. Print honor roll #1, and click Next.
4. Set your honor roll specifications, and click Done.
5. Select to run the honor roll for a grade level or all grades, or
do an individual student audit to find out why a particular
student made (or did not make) a specific honor roll.
6. Once the honor roll is generated, you can print it by clicking
the print icon (shortcut key: [F9]) at the bottom right.
Note: Always run honor rolls in order (honor roll 1 first).
1.

View/Change/Add/Drop (VCAD)
The View/Change/Add/Drop program is where student grades,
GPA, and schedule information are stored. VCAD enables users
to toggle between the transcript (e.g. Report Card) functions
and schedule functions—even if your school does not own
Scheduling. In the left-hand menu, you
will see three different view options.
Click any of the radio buttons to toggle
between the different views.

? ? Enter an Individual Student’s Grades

?

1.
2.
3.
4.
5.

In the Report Cards module, click View Change.
(Shortcut: right-click > View/Edit Grades.)
In the View Transcripts dialog box, make sure the option
Transcripts is selected at the upper-left corner.
Look up the student.
Click a course, and then click Edit [F3] on the left.
Enter the grade(s) in the appropriate cells, and click Done at
the bottom right.
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? ? View a Student’s GPA

?

1.
2.
3.

In the Report Cards module, click View Change.
(Shortcut: right-click > View/Edit Grades.)
Look up the student.
View the GPA information located at the top of the View
Transcripts dialog box under the student’s photo.

Scheduling within VCAD
Within VCAD, you can schedule students into courses and
sections. This could be as easy as changing a student’s section or
course, scheduling one student into all of his or her courses, or
block-copying a schedule from one student to all other students
in the same homeroom (or team).

? ? Add a Student to a New Course/Section

?

1.
2.
3.
4.
5.

In the Report Cards module, click View Change.
(Shortcut: right-click > View/Edit Grades.)
Click Line Schedule on the left.
Look up the student.
Right-click anywhere in the schedule table, and then click
Add New Course/Section.
In the Select a Course/Section dialog box, click a course,
and click Select.

? ? Withdraw a Student from a Course or Section

?

1.
2.
3.
4.

In the Report Cards module, click View Change.
(Shortcut: right-click > View/Edit Grades.)
Click Line Schedule on the left.
Look up the student.
Right-click the course to withdraw the student from, and
then click Withdraw this Section.

? ? Speed Schedule a Student

?

Speed scheduling is primarily used in high schools when a
student has transferred into the school after the start of school.
Speed scheduling enables you to select the courses the student
will take, and AdminPlus will schedule the student into the best
sections for his or her requested courses.
1.
2.
3.
4.

5.

In the Report Cards module, click View Change.
(Shortcut: right-click > View/Edit Grades.)
Click Line Schedule on the left.
Look up the student.
On the left, click the plus sign (+) next to New to expand it,
and then click one of the following:
• Manual Add [F2]: Requires entering the course numbers.
• Courses [F3]: Enables you to select courses from a list.
Once you have selected all the courses, click the plus sign (+)
next to All Courses & Requests, and then click Speed Sch.
to have the student be scheduled into all available courses.

Need more help?
Visit redikersupport.com to browse documentation and
videos, interact through discussion forums, get product
updates, and contact support.
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